
First Cuts for FCP
Log your clips into bins in Final Cut Pro; pass the bins to First Cuts for FCP and get back a fast 
first cut immediately, with story arc, B-roll and lower thirds. Never face the frustration of an 
empty sequence again — explore story content as a series of fast first cuts.
Please use Provide Feedback… under the application menu for bug reports, feature requests 
or support.

Quickstart Guide
1. Log in Final Cut Pro following the guidelines in Logging in Final Cut Pro, with 

ranking, story keywords, speaker on camera, location, Event or Theme and (if the 
clip is A-roll) some B-roll search terms.

2. Export the logged bins from Final Cut Pro as an XML file.
3. Run First Cuts for FCP and import the XML file.
4. Choose a duration, primary and secondary story keywords and the format of the 

Sequence you want created.
5. Click the Make the Edit button and save the result as Final Cut Pro XML.
6. Import the XML of the Sequence back to Final Cut Pro and review the Sequence.
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Logging in Final Cut Pro — setting up
The column names and preset
First Cuts for FCP uses the following Logging Columns in Final Cut Pro:

• ! Label: Change the default labels (see next page), then set the Label from 1 to 5. 
This is used for ranking the quality of Clip content/visual quality: 1 is the highest 
quality and most valuable material; 5 is the least valuable material.

• ! Good: When the Good checkbox is on First Cuts for FCP knows that this clip can be 
used to start a story or sequence. In our language we call this a “strong start” Clip.

• ! Master Comment 1: “Story Keywords” — This is where you enter keywords, or tags, 
for this clip. 

• ! Master Comment 2: “Location” – Where was this shot taken.

• ! Master Comment 3: “Speaker” – Whoʼs on camera.

• ! Master Comment 4: “Event or Theme” – in the whole arc of the documentary what 
main story or theme does this fit into.

• ! Comment A: “B-roll Search Keywords” – What keywords to search for to match B-
roll to this A-roll clip.

Setting Column names and Labels
You can set these labels, after displaying the 
column, by Control-clicking (or Right mouse clicking) 
on the column heading in List View and selecting 
Edit Heading. Then type in the new name.

Alternatively, you can choose the Edit menu and 
select Project Properties to  enter the Master 
Comments in one place.



The Labels can be set by choosing the Final Cut Pro menu and selecting User Preferences. 
Choose the Labels tab and enter 1 through 5 as the labels.

Column Layout
We have provided a template for Column Layout that displays the Columns required by First 
Cuts for FCP. It is called “TAE Layout” and is available for download.
Unfortunately we cannot provide a preset that names the Master Clip 1 to 4 and Comment A 
columns. This only needs to be done once per project. All new Bins created after that will have 
the correct column names, which are stored with the project.
We have also provided a Project Template with the columns named and displayed and Labels 
set as 1 to 5 (download).

http://AssistedEditing.com/FirstCuts/help/TAE_Layout.zip
http://AssistedEditing.com/FirstCuts/help/TAE_Layout.zip
http://AssistedEditing.com/FirstCuts/help/TAE_FCP_Template.zip
http://AssistedEditing.com/FirstCuts/help/TAE_FCP_Template.zip


Logging in Final Cut Pro — logging basics
Types of Clips
Within the logging of documentary footage, First Cuts for FCP works with these types of Clips:

• A-roll

• A+

• B-roll.

• Lower Third Titles

• Opening Titles.

A-roll
A-roll footage is where the dialog or sound track is important and should be made part of the 
edit, but the visual can be replaced with B-roll where its appropriate.
An A-roll clip has a speaker or speakers, and B-roll search keywords. If no B-roll search 
keywords are entered, B-roll will be selected for the clip based on location (if provided) or 
randomly.
A-roll clips should be trimmed or subclipped to "thought-sized" sections of an interview.

A+
An A+ clip is one where both the picture onscreen and audio/dialog are both equally 
important. B-roll will not be overlaid over an A+ clip. 
An A+ clip has a speaker and the + character in the B-roll search term field.

Note: Any A-roll or A+ clip can be identified as a “strong start” – good to start a sequence 
– by checking the “Good” checkbox ʻonʼ.

B-roll
B-roll clips are related to the action or dialog but not part of it. They are used by First Cuts for 
FCP to remove jump-cuts and to add visual interest.

Lower Third Titles
Any Motion Master Template (whether supplied by Apple or created by yourself) can be used as 
a Template for the Lower Thirds Titles added by First Cuts for FCP where appropriate.
A Lower Third Title has the words “Lower Third” in the name of the Template. (Motion Master 
Templates supplied by Apple have this naming convention.)

See: Creating Motion Master Templates at the end of this section.



Opening Title
Any Motion Master Template (whether supplied by Apple or created by yourself) can be used as 
a Template for the Opening Title in Sequences generated by First Cuts for FCP. We attempt to 
place the story keywords into the Title as a placeholder, but the variety of options for Openers 
within Motion Templates makes this more of a placeholder, ready for the editor to add the 
appropriate title information. If no Opening Title Template is supplied, First Cuts for FCP will not 
add one.
An Opening Title Template will have “Opening” or “Opener” in the name of the Template.

Note: Multiple Templates for Lower Third or Opening Titles can be sent to First Cuts for 
FCP by including them in the Bins before sending to First Cuts for FCP. You can 
choose which one to use for any individual edit from within First Cuts for FCP interface.

See: Creating Motion Master Templates at the end of this section.

Log Notes: Field by Field Description
In this section I describe in a little more detail the types of metadata/log notes that go in each 
field for First Cuts for FCP. We have provided a PDF "cheat sheet" under the Help menu that 
summarizes the log notes that are needed, optional or left blank for each type of clip — a handy 
guide while you are logging clips. Thereʼs further thoughts about logging in the FAQ.

Quality/Priority (Label)
Once set with labels identified as 1-5, the appropriate label is applied to each A-roll or A+ clip; 1 
being the highest ranking and 5 being the lowest ranking. When editing to duration, the lowest 
ranked clips will be dropped before the higher ranked clips. The ranking is purely subjective and 
should incorporate technical quality and story-relevance issues.

Strong Start (Good checkbox)
If an A-roll or A+ clip or subclip would be useful as a lead-in to a sequence or to establish the 
introduction to the story, it should be marked with the “good” checkbox on. First Cuts for FCP 
will take this setting into account when deciding which clip should start an edit. 
Keep the use of the “Strong Start” for clips that will, indeed, make sense starting a sequence. It 
is not necessary to assign this to any clip as it is optional.

Story Keywords  (Master Comment 1)
This is where you enter keywords, or tags, that describe the content of the clip. You can enter 
multiple keywords separated with a comma. When multiple words are entered, each item 
between commas is identified as a keyword. So a keyword sequence could look like: Austria, 
Austrian, going for breakfast, bread. In this example “going for breakfast” is one story keyword.
First Cuts for FCP builds an edit from clips tagged with the Story Keywords you choose. Include 
as many story keywords as there are stories that this clip will be relevant for. Avoid entering too 
many story keywords as that will make the clip come up in more edits.

http://theassistanteditor.com/FirstCuts/help/Logging%20cheat%20sheet.pdf
http://theassistanteditor.com/FirstCuts/help/Logging%20cheat%20sheet.pdf


There is no limit to the number of Story Keywords you can assign to a clip, and no limit on the 
combination. Unfortunately, while you can Control-click (or right mouse click) on the field, the each 
combination of story keywords is presented as a different item, so the contextual menu becomes 
too long and unwieldy to be useful. This means that we have to be careful to be consistent with 
story keywords, although the design of First Cuts for FCP makes it easy to select multiple versions 
of the same story keyword where typographical or other variations have crept in.

Location (Master Comment 2)
An identifier for where this clip was shot. Use the contextual menu to ensure consistency 
between data entry sessions. When right-clicking, or Control-clicking, on a field in Final Cut Pro, 
a list of existing entries for that field will be displayed making consistent entry easy. Only one 
location per clip is supported.

Speaker – whoʼs on camera (Master Comment 3)
Enter the name of the A-roll Clip's speaker on camera. Again, use the contextual menu to 
ensure consistency between data entry sessions.
If the shot starts on one speaker and ends on another, enter both names with a comma in 
between. If there is more than speaker in the shot, enter as if one name. For example:

“Dell Draxl”  when just Dell is in the shot;
“Dell Draxl, Ziggy Draxl” for when the shot starts on Dell and pans to Ziggy;
“Dell and Ziggy Draxl” for when both are in the shot together;
“Dell and Ziggy Draxl, Ziggy  Draxl” would indicate a shot that started on both and ended 
only on Ziggy Draxl.

IMPORTANT: Leave the Speaker field empty if the Clip is to be used for B-roll. Clips 
without Speakers are B-roll by definition.

Event or Theme (Master Comment 4)
While Story Keywords reflects the content of the clip, Event or Theme reflects its overall context: 
Where does it fit within the overall story arc of the documentary, or what is being referred to in 
this clip? The Event or Theme tag is used to provide context for the clip when being edited.
The Event or Theme starts with a three digit number used for ordering them, typically 001 to 
100. When first adding themes or events, space them so that there is room to add new events 
or themes between the existing keywords. The number indicates the time sequence across the 
entire time of the documentary. Use the contextual menu to ensure consistency between data 
entry sessions.
Thereʼs further thoughts about Event or Theme in the FAQ.

B-roll Search Terms (Comment A)
If this is an A-roll clip, enter keywords that would help find relevant B-roll for this clip. For A+ 
clips that donʼt need B-roll, enter a plus sign (+). Naturally, leave this field empty for B-roll clips.



Creating Motion Master Templates
First Cuts for FCP works with Motion Master Templates 
for Lower Thirds or for Opening titles. It will not work with 
any Motion Project, only those saved as a Template. (In 
Motion these are Motion Templates; in Final Cut Pro they 
show as Master Templates.) Itʼs trivial to convert from a 
Motion project — derived from an existing template or 
completely original work — to a Motion Master Template 
that First Cuts for FCP will use.
Create the Motion project as you want it to look. Before 
you save out the template, you need to make a change 
to any video layers that you want to be able to change in 
Final Cut Pro. Select the layer you want to convert to a 
drop zone, navigate to the Inspector and the Image Tab 
and click the Drop Zone checkbox ʻonʼ. Text fields are 
always editable in Final Cut Pro — at least size and content is: position, font and color are set in 
the template.
To save as a Template, choose the File menu and select Save as Template. The Save Template 
dialog opens. Format should be obvious: for an HD project, choose HD; for NTSC or PAL, choose 
them from the pop-up menu.
At first it will seem like you canʼt save the Template anywhere — all the Themes are locked. 
Click the New Theme button and create your own theme. A good approach would be to create a 
Theme for a project.
For a Master Template you have the choice of including a QuickTime Preview, so you can see 
what the effect is visually in the Final Cut Pro Master Template browser.
Whether you choose to Collect Media or not depends on whether or not you need to keep 
media with the template.
Once saved as a Motion Template, itʼs available in Final Cut Pro as a Master Template, ready to 
be used in every project 
you make.
Open a Master Template 
in the Viewer by using 
the Viewer window's 
Generator menu, or by 
using the Motion 
Template palette from 
the Sequence menu. 
Drag the Master 
Template from the 
Viewer to the Bin/
Browser to add it to your 
project.



Trimming and Subclipping
First Cuts for FCP, like most editors, works with selects (trimmed clips). It will work with any 
combination of trimmed clip, Subclip, or trimmed subclip. Personally I prefer to subclip the A-roll 
selects quite “loosely” (without cutting too tight) with the expectation that final trimming will 
happen later. 
With B-roll I trim to much longer than I ever expect to use and generate a subclip from that and 
then trim to a visually interesting duration. Most B-roll has only a certain duration that it will be 
interesting and that should guide how itʼs trimmed, within the subclip.
Tip: If you're cutting a master clip down to thought-sized subclips, enter as much metadata as 
you can — name, location, maybe event or theme — to the master clip first. Then the subclips 
will all inherit the common log notes and only need their individual variations entered.

NOTE: Any filters, including Color Correction, Motion Settings or Speed Adjustments 
added to Clips in the Bins at the logging stage will be retained and used by First Cuts 
for FCP.

Bin Structures
First Cuts for FCP will ignore the bin structures you use for your organizational purposes, as will 
as any log notes entered into any field other than those specifically mentioned above. You are 
free to use whatever bin structure you like, including bins within bins within bins.
First Cuts for FCP will find relevant clips in the exported XML based on story keywords, 
regardless of which bin they are in.

Exporting XML
Select the Bin(s) containing logged clips and from the File menu choose the Export submenu 
and select XML. If you are exporting Motion Templates you must use XML version 4 or higher.

Note: If you export to XML version 3, the Lower Third titles that First Cuts for FCP 
returns will be based on the Outline Text Title Generator.

There's more information about exporting XML at Apple's website.
Note: You can export part of the project to First Cuts by selecting Bins before exporting. 

Select one of more Bins before choosing to export XML. First Cuts will only work with 
what you send it, so this is a good way to isolate material you donʼt want to send 
(narrative parts of the project, perhaps) or to send only the trimmed or subclipped 
Clips, without the original captured Clips.

http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/Documents/chapter_2_section_2.html
http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/Documents/chapter_2_section_2.html


Using First Cuts for FCP — importing bins
Click the Browse button (or choose the File menu and select Open) to show an Open dialog. 
Select the XML file exported from Final Cut Pro containing the logged Bins. There is the option 
to cancel at this point, but First Cuts for FCP canʼt get started until it opens and parses a XML 
file with Clip information in it. Clips in Sequences, should they be exported with Bins of Clips, 
will be ignored.

Importing Bin Data
Once a suitable XML file is selected, First Cuts for FCP will take a short time to open the file, 
and then will progress through all the clips in the XML file, preparing to make Fast First Cuts for 
you.
The process of opening and parsing the XML file will vary according to the number of Clips and 
the speed of your computer.
When the clips are prepared, there will be an indication in the interface about the total duration 
of A-roll available, and primary story keywords will populate the pop-up menu and other story 
keywords fill the left hand scroll box.



Using First Cuts for Final Cut Pro — 
! making edits overview
The basic workflow for making edits within First Cuts for FCP is:

• ! Import the XML file with the Bin information;

• ! Set the maximum duration, or click the No Limit radio button;

• ! (Optional) Choose your Opener Style;

• ! (Optional) Choose your Lower Third Style (the default is Outline Text Lower Thirds);

• ! From the Available Story Keywords list, choose one or more keywords and add them 
to the Selected Story Keywords list. Story Keywords often bring additional material 
to the story. The addition of a Story Keyword that brings additional material to the 
edit will change the edit. 
Note: Because clips can have multiple story keywords for each clip, adding 
additional story keywords will not always change the edit. This happens when the 
same Clips are tagged with multiple story keywords that have been selected for the 
edit.

• ! (Optional) Set the order of the Story Keywords in the right hand box by dragging the 
Story Keywords up or down the list.

• ! (Optional) Randomize the order of the Additional Story Keywords by clicking the 
Randomize button. Each time the Randomize button is clicked a new random sort 
is created.

• ! Set the Sequence Settings for the output Sequence. Be especially careful of 
choosing the frame rate of the Sequence as that cannot be changed back in Final 
Cut Pro.

• ! (Optional) Save a snapshot of your settings by choosing the File menu and selecting 
Save Snapshot. Enter a file name and save the snapshot document.

• ! Click the Make the Edit button to generate a Fast First Cut.

• ! Enter a file name and save the XML file.

• ! Import the Sequence XML back to Final Cut Pro and review. (There's more 
information about importing XML at Apple's website.)

http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/Documents/chapter_2_section_3.html
http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/Documents/chapter_2_section_3.html


Using First Cuts for FCP — making edits

Import XML
Click to open a Final Cut Pro XML file that 
youʼve exported from your project.

Duration
Either click the No Limit radio button to use all available clips that match your story keywords, 
or click the other radio button and enter a maximum duration. Minutes and 1/10ths minutes or .1 
minute accuracy.

Note: The edit will be shorter than the 
nominated maximum. It will sometimes 
be noticeably shorter.



Opener Style
The Opener Motion Templates you included in 
your Bin Export will show in the Opener Style 
pop-up menu. Choose the one your want to 
incorporate at the start of this edit. This will be a 
placeholder ready for you to enter title details 
into.

Lower Third Style
The Lower Third Motion Templates you included 
in your Bin Export will show in the Lower Third 
Style popup menu. Select the one you want to 
use for all Lower Third titles in this edit. Lower 
Third Titles are populated with the name of the 
person on camera.

Story Keywords
First Cuts for FCP sums up all the story keywords and presents them as a list. Select story 
keywords from this list that will most characterize the story you want to explore. You can add as 
many Story Keywords as you want by adding them to right hand Story Keywords box. Story 
Keywords have show the duration of footage available – as displayed in both the list of Available 
Story Keywords and the list of Selected Story Keywords. 

You can select a Story Keyword in the left box and either:
Click the Add button to add it to the right hand box; or
Drag the Story Keyword from the left box to the right box.

Available Story Keywords can be sorted by keyword name or duration by clicking on the column 
headings. 
You can change the order of Selected Story Keywords by dragging a Story Keyword up or down 
the list. Changing the order of selected Story Keywords will change the edit.
Optionally: Click the Randomize button to randomly change the order of the Story Keywords. 
Each time the Randomize button is clicked a different random sort will be generated (and 
therefore a slightly-to-significantly different edit).
Remove: Removes a selected Story Keyword from the right hand box.
Clear: Clears the right hand Selected Story Keywords box of all Story Keywords.



Sequence Settings
In this area you set the Sequence settings that First Cuts 
for FCP will use to build your Sequence. These can be 
mostly over-ridden back in Final Cut Pro, except frame 
rate.
You will be presented with the Frame Rate(s); Frame 
Size(s); and Pixel Aspect Ratio(s) that are found among 
the Clips in your Bins. If there is only one type of media, 
there will only be one setting available. Use that default.
If there are multiple types of clips among your source then choose the settings that you want to 
use for the sequence that First Cuts for FCP will build.

IMPORTANT: Once created the frame rate of a Sequence cannot be changed in Final 
Cut Pro. That is the only setting that cannot be changed, or over-ridden on import. 
Please choose the frame rate setting wisely.

Using First Cuts for FCP — saving a Snapshot
A Snapshot is like a “freeze frame” of your current settings in First Cuts for FCP so you can 
return to this state some time in the future.
After youʼve opened your Bins of Clips, set duration, chosen an opener and a lower third, set 
sequence settings and chosen story keywords, you can save a snapshot document by choosing 
the File menu and selecting Save Snapshot. Navigate to where you want the snapshot 
document to be saved and enter a useful name.
To restore your selections from a snapshot document, either:

• Choose the File menu and select Open Snapshot; or

• Double-click a snapshot document to open it in First Cuts for FCP.

Using First Cuts for FCP — previewing the A-roll cut
Click the Preview A-roll Cut button to open a floating panel that plays the video of the A-roll 
clips in the cut.

• Previews and thumbnails are only available if the original media files are online.

• Use the Space bar to play and pause video in the Preview panel.

• The Preview panel can be resized.



Going back to Final Cut Pro
Saving XML 
Once all your settings are complete, click the Make the Edit button. The edit will be completed 
in seconds and a Save dialog will open.
Navigate to where you want the file to be saved and enter a useful name. By default the 
Sequence will be named according to the primary keyword selected. If additional Story 
Keywords are selected the default name will be the primary keyword, a comma, followed by 
"etc.”

In Final Cut Pro
Import the XML file by choosing the File menu and from the Import submenu select XML. The 
XML import dialog will open.
In the Import XML Dialog:

• ! Target the appropriate Destination — i.e. the project that you want to insert this 
Sequence into;

• ! If you choose to create a new project, Final Cut Pro will require you to name and 
save it before beginning the import.

• ! Confirm that the Reconnect to Media Files checkbox is 'on' otherwise the media will 
not be reconnected automatically.

• When ready, click OK to import.

NOTE: We do not expect any errors on import. Please report import errors to 
techsupport@intelligentassistance.com.

The Sequence will be ready for you to view and/or polish.

mailto:?subject=
mailto:?subject=


Frequently Asked Questions
Logging
More logging is good up to a point. I learned that you donʼt overload story keywords as the 
same clips keep coming up in many edits, often not so successfully. So my advice now would 
be to keep the story keywords for each clip to the minimum that really describe the clipʼs value 
to the story.  Initially I tended to load on any possible story keyword I could think of but as we 
got First Cuts for FCP closer to finished, and with the ability to selectively add as many story 
keywords as you want, I can really make the decisions of what I want to include on a much 
more fine-grained basis that way.
That multiple select also means I donʼt have to be careful about always using the same 
keyword. Itʼs obvious when Iʼm building an edit that “Austria” and “Austrian” will probably both be 
included together or excluded together. Similarly “McDonald School” and “McDonald College” 
both refer to the same place — where my subject was “discovered.” In my examples there are 
many inconsistencies among story keywords.
Names and locations have to match. Variations will be considered to be different people. First 
Cuts for FCP uses the name to fill in lower third titles and to avoid jump cuts. Likewise location 
needs to match and itʼs used to avoid jump cuts. Fortunately, FCP makes it easy to be 
consistent with these fields. After entering a name, for example, you can right-click (or Control-
click) into any other name field and pick the existing entries from the list. For Name and 
Location this makes entering the metadata very fast, and very accurate. Itʼs not like you have to 
type them twice.

How many clips are necessary?
The challenge is that First Cuts for FCP doesnʼt do so well with small numbers of clips. Youʼd 
probably want to give it at least 20 A-roll or A+ and a similar number of B-roll options to start 
seeing how it can generate multiple different editions quickly and interactively. With small 
numbers of clips the results tend to all end up very similar — pushing duration can force 
variation though.
With small numbers of clips, you might get the optimal results by doing a quick A-roll (a.k.a. 
ʻradioʼ) cut and using Finisher to complete the job.

What should I do with the clips from which I made thought-sized subclips 
for A-roll? Should they be deleted or can they be left without description?
My recommendation would be to move source or master clips to their own Bin or Bins within a 
single “masters” bin. Then when you export the XML file select all Bins except that master bin of 
masters. That will leave them out of consideration because First Cuts for FCP doesnʼt ever get 
them.
Tip: If youʼre cutting a master clip down to thought-sized subclips, enter as much metadata as 
you can — name, location, maybe event or theme — to the master clip first. Then the subclips 
will all inherit the common log notes and only need their individual variations entered.



Same for B-roll. If I leave the master clips in the bins will First Cuts for FCP 
use them?
If clips are included in the XML export then First Cuts for FCP will attempt to use them.  
Excluding Bin or Bins from the export to XML would be my current recommended practice. Itʼs a 
fairly simple matter to select all in the Browser, then Command-click (thatʼs the Apple key) on 
the Bins you want to exclude. Then Export the XML. Final Cut Pro will only export what was 
selected.

Is there a minimum length of A-roll needed?
As a consequence of this question being asked, First Cuts for FCP was changed. There is no 
minimum duration required for any story keyword. However, if there is insufficient A-roll First 
Cuts for FCP will do what it can with it, but it wonʼt necessarily be useful. Experiment.

Is there a minimum proportion required of B-roll to A-roll?
No there is no minimal proportion of B-roll to A-roll. You can send no B-roll and it will still do the 
best possible job on an A-roll edit.
In fact one of the benefits Iʼve noticed with First Cuts for FCP is that it makes it really clear 
where thereʼs no B-roll coverage on a subject, because First Cuts for FCP will place as much B-
roll as possible (within certain guidelines so people get face time). Thatʼs another benefit thatʼs 
hard to put into a user guide or marketing pitch, but itʼs really useful.

Events or Themes confuse me. In the manual you refer to story arc which 
implies that they are in part about position in time within the development 
of plot. But I am unclear if changing the numbering of the events has an 
impact on the sequences generated by First Cuts for FCP. It seems that 
order is affected by the choices made in the Story Keywords Selected 
panel.
There are many things that affect the way the story evolves in First Cuts for FCP. Story 
keywords are important in determining what will be included in the edit, but the actual 
sequencing within the story arc is affected by Events or Themes and some other minor factors. 
The way I conceived Event or Theme to work is around the idea that in any documentary there 
are relatively few real-time/real world events along the story path, or overarching themes.
But I do understand your confusion on Events or Themes. It was another of those concepts that 
evolved over development. Originally Events was supposed to be a way to bring together clips 
around a particular events within the documentary. The project I used during development is the 
story of a young singer/dancer/actor from Sydney called Tim Draxl. The documentary covers his 
early career and into his first CD and performance deals, before he got movie roles.  
So, my Events and Themes look like this (there are 20 in total, I havenʼt included all):

010 Growing Up and Family



020 Master Class
035 Tim the person
040 Beginning Career
055 Timʼs Talent at Cabaret
100 Timʼs Future
060 Recording in LA
075 Performing and Audiences
065 Developing Career

and so on.  The numbers give chronology to the overall story arc and are a way to group or 
associate ideas as material is logged.  
The Events and Themes can really be whatever you want. Events was originally intended to 
group content around the events that occurred during the documentary production. In Timʼs 
case “Recording in LA” was  a discrete event, as was “Cabaret Convention” and “Sound of 
Music.” But as we went on in development I found I wanted to use the same mechanism to 
group things other than events — what eventually became themes. 
Often the numbering is fairly arbitrary. Probably 00 to 99 is enough. I start with themes or events 
on the 10ʼs so that I have slots between if I decide (as I did) that I wanted to put the theme “Tim 
the person” between the “Master Class” and “Beginning Career.” It seemed to fit there. But I 
could just as easily renumber it to fit between “Recording in LA” and “Developing Career” by 
changing the number to 063, for example.



Activating First Cuts for FCP
After you install First Cuts for FCP onto a computer, it will need to be activated with a Serial 
Number before it can be used. Each serial number can be used to activate only one user at a 
time. If you want to activate the software on another computer, youʼll need to deactivate it first. 
See Moving First Cuts for FCP to another computer for details.
Youʼll temporarily need internet access for the activation so that the software can connect to our 
server and confirm the serial number.

• When the software is first run it will display a Software License Agreement. Read the 
license agreement and click the I Agree button at the bottom of the page.

• Enter the Serial Number that was given to you and click the Activate button. The 
software will send the serial number to our server for confirmation.

• Youʼll get a message in green saying that youʼve successfully activated your license. 
Click the Continue button.

If the software could not be activated with the Serial Number, youʼll get a message in red 
explaining the reason, such as:

• This is not a valid Serial Number — check to make sure you have entered the serial 
number correctly;

• This is not a Serial Number for First Cuts for FCP — make sure youʼre entering a serial 
number that can be used to activate First Cuts for FCP;

• The Serial Number has already been activated — if you want to activate First Cuts for 
FCP on this computer you'll need to deactivate the other installation before 
activating this one, or purchase another serial number.

Moving First Cuts for FCP to another computer
To move First Cuts for FCP from one computer to another, you'll deactivate it on the first 
computer, then activate the installation on the second computer.
To deactivate the software on one computer and activate it on a different computer, both 
computers will temporarily need internet access.

• On the first computer, choose Deactivate from the application menu.

• Confirm that you want to deactivate the software by clicking the Deactivate button.

• Youʼll receive a message in green saying that youʼve successfully deactivated your 
license.

• On the second computer, run First Cuts for FCP, and follow the instructions for 
Activating First Cuts for FCP.


